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Welcome!

Your EPSON Stylus® Photo printer delivers state-of-the-art print quality for both 
professional and home office users. With resolutions up to 2880 × 720 dpi, it’s the 
ideal output device for everything from exhibition prints to family photos. You can 
print edge-to-edge, borderless prints on a variety of roll paper sizes, or on single sheets 
of special EPSON® photo papers available in popular print sizes. 

PRINT Image Matching and Exif Print

Your EPSON Stylus 1280 printer supports both digital image formats to give you the 
best photo prints possible.

■ PRINT Image Matching™ (both P.I.M. and P.I.M. II)

■ Exif Print

About PRINT Image Matching

EPSON’s revolutionary PRINT Image Matching (P.I.M.) technology lets your digital 
camera and printer work together automatically to produce the best prints possible. 
Digital camera manufacturers that support PRINT Image Matching include EPSON, 
Casio,® JVC,® Konica,® Kyocera,® Minolta,® Nikon,® Olympus,® Panasonic,® Pentax,® 
Ricoh,® Sanyo,® and Toshiba.® Go to www.printimagematching.com to see if your 
camera supports PRINT Image Matching.

Even if your camera doesn’t include PRINT Image Matching technology, your 
EPSON Stylus Photo 1280 still gives great photo printing results. You just won’t have 
the automatic adjustments that P.I.M. provides.
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With PRINT Image Matching, the digital camera manufacturer can set specific 
printing options for each camera model. These options include:

■ Contrast, sharpness, and brightness

■ Gamma level, color space, and color saturation

■ Shadow point, highlight point, and color balance

The camera saves this information in each image file. Your printer—along with 
EPSON Software™ Film Factory™ and P.I.M. II Plug-in for Adobe® Photoshop®—
uses the information to ensure the most accurate image reproduction. 

About Exif Print

The Exif (Exchangeable Image File) Print format includes information about your 
digital camera settings in JPEG files so your printer and application can use the data 
to create accurate print settings. Most digital cameras store Exif Print information 
such as shutter speed, metering, flash, exposure settings, resolution, and lens use in the 
JPEG image file. Your printer—along with EPSON Software Film Factory and the 
P.I.M. II Plug-in for Adobe Photoshop—uses the information to ensure the most 
accurate image reproduction.

About Your Software

The printer software CD-ROM that came with your printer includes all the software 
you need for printing. (You must have a CD-ROM or DVD drive installed on your 
computer.) 

■ Your printer driver runs your printer and lets you control how your documents 
look. You can’t use your printer without it.

Note: It’s a good idea to check EPSON’s support web site periodically for 
possible updates to your printer driver. Visit http://support.epson.com and check 
the section for your product to see if there is a new driver available, free of 
charge, for downloading to your computer. Download instructions are posted for 
your convenience.
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■ Your bonus photo software includes these applications:

EPSON Software Film Factory

Photo management software that lets you organize, beautify, and 
print your photos in a flash. Supports PRINT Image Matching 
(both P.I.M. and P.I.M. II) and Exif Print. 

Adobe Photoshop Elements (Windows® XP, 98, Me, 2000, 
and NT 4.0, and Macintosh® OS 8.6 or later)

Offers unique features designed specifically for amateur 
photographers, hobbyists, and business users who want an 
easy-to-use yet powerful digital imaging solution.

Adobe Photoshop LE (Windows 95 and Macintosh OS 8.5x)

Your gateway to the Photoshop experience, Adobe Photoshop 
Limited Edition provides a basic set of the image-editing tools 
preferred by graphic design professionals.

P.I.M. II Plug-in for Adobe Photoshop (Windows® XP, 98, 
Me, 2000, and NT 4.0, and Macintosh® OS 8.6 or later)

Lets you retain PRINT Image Matching and Exif Print image 
quality when you import JPEG or TIFF files from your P.I.M., 
P.I.M. II, or Exif Print-enabled digital camera. (Works with 
Photoshop 6.0 and 7.0, and Photoshop Elements 1.0 and 2.0.)

Monaco Systems™ MonacoEZcolor™ software offer (Windows 
XP, 98, Me, and 2000, and Macintosh OS 8.6 or later)

Lets you build ICC device profiles for accurate color between 
scanned, displayed, and printed images. Your printer CD-ROM 
contains a demo version of the software.

EPSON PhotoCenter is EPSON’s free photo-sharing web site 
where you can store, organize, and share your photos; print 
high-resolution photos straight from the web; and order prints 
and custom photo gifts. Your printer software installer lets you 
add a link to the EPSON PhotoCenter on your desktop.
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About Your Documentation

To set up your printer and install its software, see the Start Here sheet. This book 
contains system requirements, important safety information, and instructions on:

■ Viewing your on-screen Reference Guide 

■ Printing with Windows or on a Macintosh 

■ Maintaining the printer

■ Solving basic problems

Warnings, Cautions, Notes, and Tips

Please follow these guidelines:

Warning: Warnings must be followed carefully to avoid bodily injury.

Caution: Cautions must be observed to avoid damage to your equipment.

Note: Notes contain important information about your printer.

Tip: Tips contain additional hints for better printing.

Viewing Your On-Screen Reference Guide

Your printer software CD-ROM includes an on-screen Reference Guide for your 
printer. The manual is in HTML format, so you need a browser—such as Microsoft® 
Internet Explorer 3.0 or later or Netscape Navigator™ 3.0 or later—to view it. If you 
are using a different browser, the pages may not display correctly. (A browser is not 
included on the printer software CD-ROM.)

Follow these steps to copy the Reference Guide to your computer:

1. Insert your printer software CD-ROM.



5

2. Windows: (If you’re using Windows XP, first click Start.) Double-click My 
Computer, double-click your  CD-ROM or DVD drive icon, then 
double-click the  EPSON icon. 

Macintosh: Double-click the  EPSON icon in your CD-ROM window. (You 
may have to double-click the EPSON icon on your desktop first.)

3. On the Install Menu, click Install Reference Guide. 

A shortcut icon for your guide appears on your desktop. To view the guide, just 
double-click the icon.

When you first open the Reference Guide, you see this screen:

Click here to 
expand the 
table of 
contents
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Click a topic on the left to expand the table of contents. After expanding the table of 
contents, you can click on the topic you want to view.

If there’s a right arrow , click it to view subtopics, then click on a topic to go to it.

Click the down arrow to close a subtopic list.

Note: If you see an icon for a graphic when viewing your Reference Guide in 
Netscape Navigator, click the Reload button to load the graphic.

Closed list, 
click to 
expand

Click to go 
to topic
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Loading Paper

This chapter explains how to load plain paper and envelopes. It also describes how to 
load, remove, and store roll paper, and what to do if your roll paper jams or feeds 
incorrectly. For instructions on loading special media, see your on-screen Reference 
Guide.

Follow the instructions in these sections:

■ “Loading Sheets” below

■ “Loading Envelopes” on page 8

■ “Loading Roll Paper” on page 10

Loading Sheets

Make sure your printer and computer are turned on.

1. Place your paper against the right edge of the sheet feeder and slide the left edge 
guide against the paper. (Don’t push the paper down into the feeder.)

2. Pull out the output tray extensions.

Slide the left edge guide against the paperDon’t load paper above 
this arrow

Pull out the output tray 
extensions
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Follow these guidelines when loading paper:

■ Load the printable side face up. It’s usually whiter or brighter than the other side.

■ Always load the short edge first, even when printing in landscape mode.

■ Load letterhead or preprinted paper top edge first.

■ Load up to 20 sheets of EPSON Photo Paper, Glossy Photo Paper, or Matte 
Paper Heavyweight.

■ Load EPSON Premium Glossy, Semigloss, and Luster Photo Paper one sheet 
at a time.

■ Don’t load paper above the arrow on the left edge guide.

Loading Envelopes

You can load up to 10 envelopes at a time, flap edge first and printable side up. 

Tip: For best results, press each envelope flat before loading it, or load one 
envelope at a time.

1. Place the envelopes against the right edge of the sheet feeder and slide the left edge 
guide against them. 

Load with the 
printable side 
up and the 
flap side down
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2. Set your printer’s thickness lever to the + position. (Remember to move the 
thickness lever back to the 0 position when you’re done printing envelopes.) 

3. Select Plain paper as the Media Type setting and choose the correct envelope size 
as the Paper Size setting. See page 16 (Windows), page 22 (Macintosh OS X), or 
page 19 (Macintosh OS 8.5.1 to 9.x) for more information. 
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Loading Roll Paper

This procedure illustrates how to load 4-inch wide roll paper, but you can follow the 
same steps to load wider roll paper. Before you begin, turn on your computer and 
printer.

1. Remove the paper support and lower the output tray. Then insert the paper 
support adapter into the positioning slots on the back of the printer, as shown. 
(The down arrows on the adapter should be positioned above the slots.)

2. Set the roll paper onto the roll paper holders. Avoid touching the printable side of 
the roll paper as much as possible.
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3. Before loading the paper, make sure 
the edge is cut cleanly—at a 90 
degree angle in each corner—to 
ensure proper loading. If necessary, 
trim the edge using a straight-edge 
tool or triangle.

Note: Make sure that the end of the roll paper is cut perpendicular to the edges. A 
diagonal cut may cause paper feeding problems.

4. If necessary, uncurl the paper. Locate the uncurling sheet that came inside the 
printer box. Insert the paper inside the uncurling sheet and roll it in the direction 
opposite to the paper’s curl. (This step is especially important with roll paper that 
is wider than 4 inches.)
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5. Insert the tabs on the roll paper holders into the slots on the paper support 
adapter. As you face the front of the printer, insert the tab on the right roll paper 
holder into the slot at the right end of the adapter, and the tab on the left roll 
paper holder into the appropriate slot to the left.

Note: It’s important to insert the tab on the right roll paper holder into the slot at 
the right end of the adapter. Otherwise your roll paper won’t load correctly, and 
you may see an error.

6. Feed the end of the paper into the printer as far as it will go, then slide the left 
edge guide against the paper.

7. Gently rotate the roll backward to remove any slack from the paper.

8. Make sure the output tray is open but the extensions are closed, and leave ample 
room at the front of the printer for your paper to eject smoothly.

Slot at right end 
of the adapter
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9. Gently hold the paper in place as you press and release the z roll paper button to 
feed the paper into the printer.

Note: Don’t force the paper to feed into the printer. Allow the paper to move 
automatically.

Make sure to press the z roll paper button when you feed roll paper. Pressing the b 
maintenance button by mistake may cause paper feeding problems.

If the Roll Paper Jams or Feeds Incorrectly

If the paper feeds incorrectly, do the following:

1. Press the z roll paper button for three seconds to rewind the paper. (You may 
have to do this more than once to rewind the paper completely.)

If the paper is jammed and won’t rewind, turn the printer off. Then cut the roll at 
a point a few inches away from where it exits the printer. Make your cut as 
straight as possible to avoid further feeding problems. Gently pull the roll 
backward to rewind it, and then turn the printer on again.

2. After you rewind the paper, the b maintenance light comes on. Press the 
b maintenance button to turn the light off.

3. Reload the paper, making sure the end is straight and not damaged. If necessary, 
trim the end again before reloading.
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Removing and Storing Roll Paper

When you finish a print job on roll paper, you can position the paper for another 
print job or remove it from the printer. Follow these steps:

1. Press the z roll paper button. The printer 
prints a small line on the roll paper to show you 
where to cut it and feeds the paper forward.

2. If you want to continue printing on roll paper, 
press the z roll paper button again; the paper 
feeds back into the printer. Then send the next 
print job; the paper will move into the correct 
loading position before printing.

If you’re finished printing on roll paper, follow 
the rest of the steps to remove it.

3. Cut the roll paper on the side of the line facing away from the printer. Make your 
cut as straight as possible to avoid feeding problems.

Note: Don’t pull on the paper as you cut it; you may damage your printout. 

It’s a good idea to use a ruler or straight edge to make sure the end of the roll 
paper is cut at right angles. A diagonal cut may cause paper feeding problems.

4. Hold down the z roll paper button for about three seconds. The roll paper feeds 
backward, so you can remove it from the sheet feeder. (You may need to repeat 
this step to back it all the way out.)

5. Remove the roll paper from the holder and return the unused roll to its original 
package.

Store your printout in a resealable plastic bag. Keep both printed and unused roll 
paper away from high temperatures and humidity and out of direct sunlight.

Note: After you rewind the roll paper, the b maintenance light remains on. You 
must press the b maintenance button to turn the light off before you can resume 
printing.

Roll paper button
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Printing from Start to Finish

Here’s what to do to print a basic document—such as a photograph or newsletter—
from loading the paper to selecting print settings to controlling the print job. 

Follow the instructions in these sections:

■ “Basic Printing in Windows” on page 16

■ “Basic Printing on a Macintosh” on page 19

■ “Customizing Your Print Settings” on page 25

■ “Selecting the Correct Media Type” on page 32

■ “Printing BorderFree Photos” on page 33

■ “PRINT Image Matching and Exif Print” on page 34
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Basic Printing in Windows

This section describes the basic steps for printing with Windows. Make sure you have 
paper in the printer. After you create your document in a software program, follow 
these steps to print:

1. From the File menu, click Print. You see your application’s Print window (your 
window may look slightly different):

2. Make sure your EPSON Stylus Photo printer is selected.

3. Click Properties or Preferences. (If you see a Setup, Printer, or Options 
button, click it. Then click Properties or Preferences on the next screen.)

Note: If you click the print icon on your application’s tool bar instead of selecting Print 
from the File menu, you may not get the option to change the printer software 
settings before printing.

Click here to open 
your printer software

Select your printer here
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You see your printer settings window.

4. Make the following settings:

■ Choose the Media Type for your paper. If you’re 
not sure which setting to select, see page 32. 

■ For Ink, select Color to print a color document 
or black and white photograph, or Black to print 
a grayscale or black text document.

■ Set the Mode to Automatic. It’s the easiest way 
to get good printing results on all types of paper.

■ Set the slider in the Mode box to Quality or 
Speed to select high-quality or faster printing. (The slider may not be 
available for some Media Types.)

5. Click OK to save your settings, return to the Print window, and print.

Note: For more information about printer settings, click the Help button. You can 
also right-click any item on the screen and then click What’s This?.

Select higher-quality or faster 
printing

Select the type of paper you loaded

Select Automatic mode

Select the Ink color

Click OK
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After a moment, this window appears and shows the progress of your print job. You 
can use the buttons to cancel, pause, or restart printing. You can also see how much 
ink you have left.

Selecting the Settings You Use Most Often

Your printer settings apply only to the program you’re currently using. If you usually 
print one type of document in different applications—for example, text on letter-size 
paper—you can change the Windows default printer settings for all your programs.

1. Windows XP: Click Start > Control Panel > Printers and Other Hardware > 
Printers and Faxes.

Other Windows systems: Click Start > Settings > Printers.

2. Right-click your EPSON Stylus Photo printer icon.

3. Select Properties (Windows XP, 98, or Me), Printing Preferences (Windows 
2000), or Document Defaults (Windows NT).

4. If you have Windows XP, click the Printing Preferences button.

5. Select the default settings you want to use for all your applications. Click OK 
when you’re finished.

If you want different settings for a particular document, you can still change the 
settings in your application program. However, if you want to change your default 
settings, you must repeat this procedure.

Click to cancel printing

Does not 
appear if you 
are printing 
over a network

Click to pause or resume 
printing

Shows ink levels; the 
color of ink with the 
least amount left 
determines the level for 
all the colors shown 
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Basic Printing on a Macintosh

After you create a document in a software program, follow the steps in one of these 
sections to print it using the basic printing settings:

■ For Macintosh OS 8.5.1 to 9.x applications, see the next section.

■ For Macintosh OS X applications, see page 21.

Printing with OS 8.5.1 to 9.x

Before you begin, make sure you selected your printer in the Chooser, as described on 
the Start Here sheet.

1. From the File menu, click Page Setup. You see a window like the following:

2. Make sure your EPSON Stylus Photo Printer (SP 1280) is selected. If not, you 
need to select your printer in the Chooser, as described on the Start Here sheet.

3. Select the correct Paper Size, Orientation, and other settings. Then click OK.

Make sure you see 
SP 1280

Select your paper size

Select the orientation of 
your document or image
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4. From the File menu, click Print. You see a window like the following:

5. Make the following settings:

■ Choose the Media Type for your paper (click the 
arrow to display the Media Type list). If you’re not 
sure which setting to select, see page 32. 

■ For Ink, select Color to print a color document or 
black and white photograph, or Black to print a 
grayscale or black text document.

■ Set the Mode to Automatic. It’s the easiest way to get good printing results 
on all types of paper.

■ Set the slider in the Mode box to Quality or Speed to select higher quality or 
faster printing. (The slider may not be available for your Media Type.)

6. You can also do the following:

■ Click to reduce or enlarge your printed image, print multiple layouts, or 
add a watermark.

■ Click to control background printing.

■ Click , then click Preview to preview your print job.

■ Click to check your ink levels. 

7. Click Print to start printing. 

Select Quality or 
Speed (for faster 
printing)

Select your paper 
type (see 
page 32)

Select Automatic mode

Select the 
Ink color
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If you turned on background printing, you can select EPSON Monitor3 from the 
Macintosh Application menu to see this window:

Tip: If you’re not using background printing and you need to cancel printing, hold 
down the J key and press the . (period) key.

Printing with OS X

If you’re using an OS X compatible printing application, follow the steps below to 
print a document. (If you’re using an application that’s compatible only with 
Macintosh Classic mode, follow the steps on page 19 instead.)

Before you begin, make sure you added your printer to the Print Center as described 
on the Start Here sheet.

1. Open a photo or document.

2. From the File menu, select Page Setup.

Click to cancel printingClick to pause printing

Click to restart your print job

Click on the 
current print job
or
a waiting print 
job . . .

Then click here to 
view details of the 
selected print job 
and control print 
job priorities

Click to check
ink levels
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3. Select the following Page Setup settings as necessary:

4. When you’re finished, click OK.

5. Select Print from the File menu. You see a screen like this:

6. Select Print Settings from the pull-down menu.

Select your printer in the 
Format for pop-up menu

Select the Paper Size, 
Orientation, and any 
other settings you 
want to use

Click here and 
select Print 
Settings 
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You see the following window:

Tip: For more information about printer settings, click Help. The Macintosh OS X 
printer driver contains a subset of the settings available with the Macintosh 
OS 8.5.1 to 9.x printer driver described in this book. For example, double-sided 
printing is not available on Macintosh OS X.

7. Make the following settings:

■ Choose the Media Type for your paper. If you’re not sure which setting to 
select, see page 32.

■ For Ink, select Color to print color documents or black and white 
photographs, and Black to print grayscale or black text documents.

■ Set the mode to Automatic. It’s the easiest way to get good printing results 
on all types of paper.

■ Set the slider in the Mode box to Quality or Speed to select higher quality or 
faster printing. (The slider may not be available for your Media Type.)

Select Quality or Speed 
(for faster printing)

Select your paper type 
(see page 32)

Select Automatic mode

Select Color for color 
documents and black and 
white photographs
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8. You can also select these options in the pull-down menu:

■ Copies & Pages, to select the number of copies or a page range

■ Layout, to select page layout options

■ Output Options, to save your print job as a PDF file

■ Color Management, to select ColorSync,® adjust the color controls, change 
the gamma setting, or turn off color adjustments by the printer software

■ Summary, to view a list of all your selections

■ Save Custom Setting, to save your selections for future use.

9. Click Print.

10. To monitor the progress of your print job, click the Print Center icon when it 
appears in the dock on the bottom of your desktop. For OS X 10.2, double-click 
Stylus Photo 1280 in the printer list. You see a screen like this:

11. Monitor the progress of your print job or do one of the following:

■ Click the print job, then click Delete to delete the job.

■ Click the print job, then click Hold to pause printing.

■ Click a print job marked “Hold” and click Resume to resume printing.

■ If multiple print jobs are listed, click a print job, then click the Priority arrow 
as necessary to reorder the jobs (not available for OS X 10.2).

12. When you’re finished, close Print Center.
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Customizing Your Print Settings

You can use advanced settings for color matching, printing at a higher resolution, or 
selecting a variety of special effects and layouts.

Customizing Windows Print Settings

1. On the Main tab, click Custom.

2. Optionally, select one of these settings from the Custom Settings list:

■ Economy: For printing rough drafts of text on plain paper.

■ ICM (Image Color Matching): For matching colors as closely as possible with 
ICM-compatible monitors or scanners.

■ sRGB (standard Red Green Blue): For color matching with other sRGB 
devices, or for images designed for the Web. See your Windows help for 
details.

Click Custom, then choose 
from the Custom Settings list 
or . . . click Advanced
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3. Click the Advanced button. You see the Advanced window:

Note: You must click Custom to see the Advanced button.

4. For higher quality printing (higher resolution), select Photo - 1440dpi or 
SuperPhoto - 2880dpi (if available for your Media Type). Then click OK.

Note: Printing is slower at higher resolutions. For more information about 
advanced settings, click the Help or  button.

5. Set any other advanced settings you want to use. 

6. If you want to save your custom settings as a group, click Save Settings. Then 
enter a name for your settings in the Custom Settings window and click Save.

Note: When you want to use them again, you can select this group of settings in 
the Custom Settings list on the Main menu. You must click Custom to see the 
Custom Settings list.

Select higher print quality 
(higher resolution)

Select color 
management settings

Select 
various print 
options

Set individual 
color values

Click to save 
settings
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7. Optionally, click the Paper tab to change paper size, page orientation, or the 
paper source. If you’re printing on roll paper, change the Paper Source to Roll 
Paper.

Tip: If your program’s Print window includes options for setting the number of 
copies, orientation, or paper source, check these before you print to make sure 
they’re correct.

Select Sheet Feeder 
or Roll Paper here

Select sheet, roll, or 
envelope size here

Select the number of 
copies and other 
output options

Select orientation, 
or rotate the image

Center your text or 
image, or increase 
the printable area

Shows current 
settings
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8. Optionally, click the Layout tab to make layout settings:

9. Click OK to save your settings and return to the Print window, then click OK (or 
Print) to print.

Select image resizing 
options here; these 
affect only your 
printed image

Click here to print on 
both sides of the page

Select settings here 
to print multiple 
pages on one sheet, 
or create a poster

Add a watermark to a 
printed page here

Shows current 
settings
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Customizing Macintosh Print Settings

1. On the printer settings window, click Custom, then click the Custom Settings 
list to open it. 

2. Optionally, select one of these settings from the Custom Settings list:

■ Economy: For printing rough drafts of text on plain paper.

■ ColorSync: For matching printed colors as closely as possible with ColorSync 
compatible devices.

Macintosh 

OS 8.5.1 to 9.x

Macintosh OS X

Click Custom, then click the Custom 
Settings list that appears

Click Custom, then click the 
Custom Settings list that 
appears
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3. To access advanced settings, click Advanced Settings (OS X) or the Advanced 
button (OS 8.5.1 to 9.x). You see this window:

Note: For OS 8.5.1 to 9.x, you must click Custom to see the Advanced button.

Note: For more information on advanced settings, click Help (OS X) or 
(OS 8.5.1 to 9.x).

Select color management 
settings here

Click here to select higher print 
quality (higher resolution)

Select various print 
options here

Macintosh OS 8.5.1 through 9.x

Select various print options here

To select color management 
settings, select Color 
Management from the Print 
Settings pull-down menu

Macintosh OS X

Click here to select higher print 
quality (higher resolution)
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4. For higher quality printing (higher resolution), select Photo - 1440dpi or 
Photo - 2880dpi (if available for your Media Type).

5. Set any other advanced settings you want to use. 

6. For OS 8.5.1 to 9.x, click Save Settings if you want to save your advanced 
settings as a group. Enter a name for your settings in the window that appears and 
click Save. 

Note: When you want to use them again, you can select this group of settings 
from the Custom Settings list on the printer settings dialog box.

7. OS 8.5.1 to 9.x: Click OK to save your settings, then click Print.

OS X: Click Print.
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Selecting the Correct Media Type

Select the correct Media Type setting so your printer knows 
what kind of paper you’re using and adjusts the ink 
coverage accordingly. 

For this paper . . . Select this Media Type setting

Plain paper sheets or envelopes

EPSON Premium Bright White Paper

Plain paper

EPSON Iron-On Transfer Paper 360 dpi Ink Jet Paper

EPSON Photo Quality Ink Jet Paper

EPSON Photo Quality Ink Jet Cards

EPSON Photo Quality Self Adhesive Sheets

Photo Quality Ink Jet Paper

EPSON Matte Paper Heavyweight

EPSON Double-Sided Matte Paper

Matte Paper - Heavyweight

EPSON Photo Paper Photo Paper 

EPSON Glossy Photo Paper

EPSON All-Purpose Glossy Paper

EPSON Photo Quality Glossy Paper

EPSON Glossy Photo Greeting Cards

EPSON Panoramic Glossy Photo Paper

Glossy Photo Paper

EPSON Premium Glossy Photo Paper 
(including roll paper)

EPSON Premium Luster Photo Paper 
(including roll paper)

EPSON Semigloss Photo Paper (including 
roll paper)

Premium Glossy Photo Paper

EPSON ColorLife Photo Paper ColorLife Photo Paper

EPSON Photo Stickers® Photo Quality Glossy Film

EPSON Ink Jet Transparencies Ink Jet Transparencies
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Printing BorderFree Photos

You can print your photos with no margins, extending the image all the way to the 
edges of the page. Although BorderFree printing is a bit slower, you get beautiful 
snapshots or enlargements, without trimming. (Not available with Macintosh OS X.)

You can print BorderFree photos on a variety of paper types and sizes. See the inside 
back cover for a complete list of paper types, sizes, and ordering information.

BorderFree Printing with Windows

Follow these steps to print BorderFree photos:

1. Start your photo application and open your photo file.

2. Click File > Print. Then click Properties or Preferences.

3. Select your paper type as the Media Type option. (See the inside back cover for a 
list of paper types that are compatible with BorderFree printing.)

4. Select Quality (for higher quality) or Speed (for faster printing) using the slider.

5. Click the Paper tab. You see the 
following:

6. Choose Sheet Feeder as your Paper 
Source. 

7. Click the Borderless checkbox. Read 
the message and click OK.

8. Select your Paper Size setting, then click 
OK.

9. Click OK or Print.
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BorderFree Printing with Macintosh OS 8.5.1 to 9.x

Follow theses steps to print BorderFree photos.

1. Start your photo application and open your photo file.

2. Click File > Page Setup. 
You see the following:

3. Select your Paper Size.

4. Choose Auto Sheet 
Feeder as the Paper 
Source.

5. Click the Borderless 
checkbox. Read the message 
and click OK.

6. When you’ve finished making page setup settings, click OK.

7. Click File > Print. 

8. Select your paper type as the Media Type option. (See the inside back cover for a 
list of paper types that are compatible with BorderFree printing.)

9. Select Quality (for higher quality) or Speed (for faster printing) using the slider. 
Then click Print.

PRINT Image Matching and Exif Print

With PRINT Image Matching and Exif Print, special print settings such as white 
balance, color saturation, and exposure time are saved in your digital photo files. 
When you use compatible programs like Film Factory and the P.I.M. II Plug-in for 
Adobe Photoshop, these settings are automatically included in your print file to 
produce the best prints possible. 

Note: For instructions on using the P.I.M. II Plug-in for Adobe Photoshop, see 
page 39.
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Using Film Factory

In addition to supporting PRINT Image Matching and Exif Print, Film Factory is a 
useful tool for organizing, retouching, and printing all of your digital images. 

Note: If you’re running Mac OS X and want to print P.I.M. and Exif Print-enabled 
digital photos, use the P.I.M. II Plug-in for Adobe Photoshop (see page 39 for 
details). Although Film Factory for Mac OS X does not support P.I.M. and Exif 
Print, you can still use its other features to print beautiful photo prints. 

Opening Your Photos in Film Factory

Follow these steps to print photos with Film Factory:

1. Start Film Factory. You see the main Film Factory screen:
 

Note: If you need help with Film Factory, select it from the Help menu or check 
the on-screen Getting Started Guide that was installed with Film Factory.

2. Select a “roll of film” or click the Roll button and select New Roll.

Click Roll to create 
a new roll, or . . .
click an existing roll

PRINT Image 
Matching 
photos have 
this logo
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If you created a new roll or you want to add photos to an existing roll, you need to 
import the photos. Click the Import button, then:

■ Click From File to import a photo from your computer’s hard drive.

■ Click From Removable Media to import a photo from a disk or CD-ROM. 

■ Click From PC Card to import a photo from a PC card in a card reader.

■ Click From Twain Device to import a photo from a scanner or digital 
camera. If your device is already selected, the software will open. If not, click 
Import Settings, and select your scanner or digital camera. (Not applicable 
to OS X.)

3. Optionally, right-click (Windows) or Ctrl-click (Macintosh) a photo thumbnail 
to display information about the PRINT Image Matching or Exif Print data in 
the photo file. 

If your photos were taken with a digital camera that supports PRINT Image 
Matching, the P.I.M. logo appears in your photo thumbnails. Although no 
logo appears on photo thumbnails for Exif Print, most newer digital cameras 
support one of these technologies. 

Note: If you retouched a PRINT Image Matching photo, the P.I.M. logo may 
not appear.

4. Click the photo you want to print, or click the All button at the top of the screen 
to select all the photos in a roll. 

5. Click a button on the left to select a print option. For 
example, click the Standard Prints button. You see buttons 
for each step you need to follow, as shown. 

6. Click Import & Retouch to retouch or edit your photo, if 
necessary.

7. When you’re ready to print, continue with the steps in the next section.

Note: You can rotate, trim, and correct for red eyes and still 
retain P.I.M. or Exif Print data with your photograph. 
However, if you adjust other settings, such as brightness 
and color, these settings are not retained. For this reason, it 
is a good idea to make a copy of the original image before 
you edit it.
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Printing Your Photos

1. When you’re ready to print, click the Print Assignment button. You see this 
screen:

2. Windows and Macintosh OS 8.5.1 to 9.x: Select these options in the Printer 
Settings box at the bottom of the screen, in this order: 

If you want to print BorderFree photos, select either Sheet Feeder (No 
Margins) or Roll Paper (No Margins) as your paper source. Also, select one of 
the following Media Type options: Glossy Photo Paper, Premium Glossy 
Photo Paper, or Matte Paper - Heavyweight. See the inside back cover for 
information about media that support BorderFree printing.

Click to print the 
date with your photo

Select your printer 
settings here

1 Make sure your printer is selected 

2 Select your paper source

3 Select your paper size

4 Select a Media Type
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Macintosh OS X: Click the Properties button. Select your printer in the 
Format for menu, select the correct Paper Size setting, and click OK. (Neither 
BorderFree printing nor roll paper support are available for OS X.)

3. If you want to print the current date with your photo, click the Print Date box.

4. Click the Print button on the left side of the screen. You see more options:

5. If your photo doesn’t look right in the preview, click the Back button to change 
your settings. (Click the Detailed Preview button for a closer look.)

6. Select the number of copies you want to print. 

7. Leave the PRINT Image Matching or Exif Print box checked for the best results 
when printing photos containing PRINT Image Matching or Exif Print data. 

8. Click the Print button at the top of the screen. 

■ Windows: Your pictures are printed.

■ Macintosh OS 8.5.1 to 9.x: You see the Print window; click Print. Your 
pictures are printed.

■ Macintosh OS X: You see the Print window. Select Print Settings from the 
Copies & Pages pull-down menu. Then select your Media Type and other 
print settings as necessary, and click Print.

Select the number of 
copies you want to print 

If you’re using P.I.M. or Exif 
Print, make sure the 
appropriate box is checked for 
the best printed output.
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Store your prints in resealable plastic bags, photo albums, or glass-covered picture 
frames. Keep your pictures and unused paper away from high temperatures, humidity, 
and direct sunlight. Make sure you return unused paper to its original package. 

Using the P.I.M. II Plug-in for Adobe Photoshop

Like Film Factory, the P.I.M. II Plug-in for Adobe Photoshop allows you to retain the 
special image settings saved in digital photo files from your P.I.M., P.I.M. II, or Exif 
Print-enabled digital camera. It works with Photoshop 6.0 or 7.0, and Photoshop 
Elements 1.0 and 2.0. You’ll also need to install the ICC profiles for your printer if 
you’re running Windows (see the Start Here sheet for instructions). If you have a 
Macintosh, the ICC profiles were installed with your printer driver.

You can crop, rotate, resize, work with layers, play with filters, and even make 
selective color adjustments to the image while retaining your PRINT Image Matching 
or Exif Print settings. However, you can’t use global color adjustments (such as Auto 
Levels, Auto Contrast, Auto Color, etc.) and retain the settings. Also, if you save the 
image and then try to use your new Photoshop file in another software program that 
supports PRINT Image Matching or Exif Print, it won’t be recognized as a P.I.M. or 
Exif Print image. Copy the original file and make your changes to the copy so the 
original retains its information for use in other programs.

Note: Photoshop doesn’t retain the PRINT Image Matching or Exif Print 
information separately in the header file when you import your image. Instead, it 
converts that information in the file and embeds a color space called EPSON RGB 
2001. This profile supports all the PRINT Image Matching and Exif Print color 
advantages and enhancements. 

Importing an Image

1. If you’re using Photoshop Elements, change your color settings before importing 
a PRINT Image Matching or Exif Print image. 

■ For Windows or Macintosh OS 8.5.1 to 9.x, select Color Settings from the 
Edit menu, then select Full color management - optimized for Print and 
click OK.

■ For Macintosh OS X, select Color Settings from the Photoshop Elements 
menu, then select Full color management - optimized for Print and click 
OK.
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2. Open the File menu and select 
Import > PRINT Image Matching II. 
You see a window like this:

3. Open the folder containing your images. 
(In Windows, all your files are listed; on a 
Macintosh, only PRINT Image 
Matching or Exif Print files appear.)

4. Select the image you want to import.

5. To see a preview of the selected image, 
check the Image Preview box.

6. Select your import option: PRINT Image 
Matching II, Exif Print, or Color extension only.

7. Click the Open button. Your image opens and the window remains on the screen.

8. Select and open more images, or click Cancel to close the Open PRINT Image 
Matching II file window. (If you don’t want the window to remain on the screen 
after you open a file, uncheck Import consecutively.)

9. Follow the steps in the next section to print your image.

To keep the header information intact for use in other PRINT Image Matching or 
Exif Print-enabled programs, keep the original file; don’t use the Photoshop Save 
command. Instead use Save As to rename the file. It won’t contain header 
information, but will retain the image quality achieved by these technologies, as long 
as the file is saved with the ICC profile embedded. 

Note: If you overwrite your original file, you will lose all PRINT Image Matching or 
Exif Print header information.

Note: If you see this screen, 
select Use the embedded 
profile and click OK.
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Printing an Image

PRINT Image Matching and Exif Print images are converted into the EPSON RGB 
2001 color space. To retain their quality and enhancements, don’t change the color 
space.

Note: The illustrations in the sections below show Macintosh screens; Windows 
screens will look different, but the settings are the same.

1. Open the File menu, then:

Photoshop 7.0 or Elements: Select Print Preview (or Print with Preview). 
Make sure the Show More Options checkbox is selected, then select Color 
Management from the Output pull-down menu.

Photoshop 6.0: Select Print.

You see this window:

2. In the Source Space box, make sure the EPSON RGB 2001 option is selected.

3. In the Print Space box, select the Stylus Photo 1280 profile for the paper you’re 
printing on. We recommend Perceptual as the Intent setting.

4. Photoshop 7.0 or Elements: Click Print.

Photoshop 6.0: Skip to step 5.

Make sure this source is selected

Select the profile for your printer and paper

Photoshop 7.0/Elements Photoshop 6.0
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5. Windows: Click Properties or Preferences. Then select the Media Type 
setting.

Macintosh OS 8.5.1 to 9.x: Select the Media Type setting.

Macintosh OS X: Select Print Settings from the Copies & Pages pull-down 
menu. Then select your Media Type.

6. Windows: Click Custom, then click the Advanced button that appears. You see 
the Advanced screen.

Macintosh OS 8.5.1 to 9.x: Under Mode, click Custom, then click the 
Advanced button that appears. You see the Advanced screen.

Macintosh OS X: Select Color Management from the Print Settings pull-down 
menu.

7. Windows: Select No Color Adjustment and click OK.

Macintosh OS 8.5.1 to 9.x: Select No Color Adjustment and click OK.

Macintosh OS X: Select No Color Adjustment.

8. Continue clicking OK (Windows) or click Print (Macintosh) to print your photo.
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Maintaining Your Printer

This section describes maintenance procedures to keep your printer working at its best 
and preparation steps for moving your printer. Follow the instructions in these 
sections: 

■ “Cleaning the Print Head” below

■ “Replacing an Ink Cartridge” on page 7

■ “Aligning the Print Head” on page 11

■ “Cleaning the Printer” on page 13

■ “Transporting the Printer” on page 14

For more details, see your on-screen Reference Guide, as described on page 4.

Cleaning the Print Head

If your printed image is unexpectedly light, or dots are missing from the image, you 
may need to clean the print head. This unclogs the nozzles so they can deliver ink 
properly. Cleaning the print head uses ink, so clean it only if print quality declines. 

This section explains how to clean the print head using the printer’s Head Cleaning 
utility, which is the recommended method when the printer is connected directly to 
your computer (not over a network). 

You can also clean the print head by holding down the b maintenance button on the 
control panel for three seconds (when the b maintenance light is off). 

Caution: When you don’t turn on your printer for a long time, the print quality can 
decline. It’s a good idea to turn on your printer at least once a month to maintain good 
print quality.
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Running the Head Cleaning Utility

Follow these steps to run the Head Cleaning utility:

1. Make sure the printer is on but not printing, and the b maintenance light is off.

Note: You can’t clean the print head if the b maintenance light is flashing or on. 
Replace the appropriate ink cartridge instead.

2. Windows: Open an application and select Print from the File menu. Click 
Properties or Preferences. Then click the Utility tab.

Macintosh OS 8.5.1 to 9.x: Open an application and select Print from the File 
menu. Then click the  Utility button at the top of the dialog box.

Macintosh OS X: Open the Applications folder on your hard drive. 
Double-click EPSON Printer Utility and select SP 1280 in the printer list. Then 
click OK.

3. On the Utility menu, click the Head Cleaning button.

4. Follow the instructions on the 
screen to clean the print head. 

Cleaning takes about 30 seconds, 
during which the printer makes 
some noise and the Ppower light 
flashes. 

Caution: Never turn off the printer while the Ppower light is flashing, unless the 
printer hasn’t moved or made noise for more than 5 minutes.

5. When the Ppower light stops flashing, run a nozzle check to confirm that the 
print head nozzles are clean.

Make sure paper is loaded in the printer and click Print nozzle check pattern 
(Windows) or Confirmation (Macintosh). Then click Next. The nozzle check 
pattern prints (see the next section for details).
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6. If the nozzle check pattern has no gaps in its lines, click Finish.

If the pattern has white lines, click Clean to clean the print head again. 

If you don’t see any improvement after cleaning three or four times, check the 
solutions in “Print Quality Problems” on page 22. You can also turn the printer 
off and wait overnight—this allows any dried ink to soften—and then try cleaning 
the print head again.

Examining the Nozzle Check Pattern

Examine the nozzle check pattern you print. It should look something like this:

Each staggered horizontal and straight vertical line should be complete, with no gaps 
in the dot pattern. If your printout looks okay, you’re done. 

If there are gaps in the lines, clean the print head again; see page 5 for instructions.

Replacing an Ink Cartridge

When the b maintenance and P power lights are both flashing, one of your ink 
cartridges is low on ink. This is a good time to make sure you have a new cartridge. 
When the b maintenance and P power lights both stay on, an ink cartridge is empty 
and you need to replace it.

Caution: You cannot print if either ink cartridge is empty. Leave the empty cartridge 
installed in the printer until you have obtained a replacement; otherwise the ink 
remaining in the print head nozzles may dry out.

Gaps in nozzle check pattern

Gaps in nozzle check pattern
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When an installed ink cartridge is more than six months old, you may also need to 
replace it if you notice that your printouts don’t look as good as they used to. If print 
quality doesn’t improve after cleaning and aligning the print head, you can replace the 
cartridge even if the b maintenance and P power lights aren’t flashing. 

Use these EPSON ink cartridges within six months of installing them and before the 
expiration date on the package:

■ Black: T007201

■ Color: T009201

Caution: To ensure good results, use genuine EPSON ink cartridges and do not refill 
them. Other products may cause damage to your printer not covered by EPSON’s 
warranty.

When you need new ink cartridges, contact your dealer or call the EPSON Store  at 
(800) 873-7766. You can also visit the EPSON Store at www.epsonstore.com (U.S. 
sales only). In Canada, please call (800) 463-7766 for dealer referral.

Removing and Installing Ink Cartridges

Be sure you have a new ink cartridge before you begin. Once you start the ink 
cartridge replacement procedure, you must complete all the steps in one session.

Follow these steps to replace ink cartridges:

1. Make sure the printer is turned on and not printing.

2. Open the printer cover and press the ink 
cartridge replacement button. The print 
head moves left to the ink cartridge 
replacement position.

Caution: To avoid damaging the printer, 
never move the print head by hand.

SM

Ink cartridge 
replacement 
button
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3. Check the ink levels in the printer driver to see which cartridge you need to 
replace:

Windows: Check the ink level graphic in the printer software. See page 16 for 
instructions on opening the software.

Macintosh OS 8.5.1 to 9.x: Click the  ink level icon in your main printer 
settings dialog box. See page 20 for instructions on accessing the dialog box.

Macintosh OS X: Open the Applications folder on your hard drive. 
Double-click EPSON Printer Utility and select SP 1280 in the printer list. Click 
OK, then click EPSON StatusMonitor.

4. The color cartridge is on the right and the 
black cartridge is on the left. Pull up the ink 
cartridge clamp. The cartridge rises from its 
holder. 

5. Lift the cartridge out of the printer and 
dispose of it carefully. 

Warning: Keep ink out of the reach of children.

If ink gets on your hands, wash them thoroughly 
with soap and water. If ink gets in your eyes, 
flush them immediately with water.

6. Unwrap the new ink cartridge. Then remove 
only the yellow tape seal on top. 

Caution: You must remove the yellow seal from 
the top of the cartridge or you will permanently 
damage the cartridge.

Don’t touch the green circuit board on the back of 
the cartridge; you may inhibit normal operation 
and printing. Black cartridge Color cartridge
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7. Tilt the new cartridge toward you slightly 
as you insert it. Lower the cartridge so that 
the tabs rest on the hooks.

Caution: Don’t place the cartridge tabs 
under the hooks on the holder clamp; you 
may damage the clamp when you close it.

8. Press down firmly on the 
ink cartridge clamp until it 
snaps into place.

9. If you need to replace the 
other ink cartridge, repeat 
steps 4 through 8 before 
continuing with step 10.

10. Press the ink cartridge replacement button and close the printer cover. The printer 
moves the print head and begins charging the ink delivery system.

The Ppower light flashes, and the printer makes noise. Charging takes about one 
minute. When it’s finished, the Ppower light stops flashing and stays on.

Caution: Never turn off the printer while the Ppower light is flashing, unless the 
printer hasn’t moved or made noise for more than 5 minutes.

Hooks

Tabs

Make sure the 
cartridge tabs are 
positioned above 
the hooks
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Aligning the Print Head

If your printouts contain misaligned vertical lines, you may need to align the print 
head. Your printer must be connected to a local port, not on a network, to use the 
Print Head Alignment utility. Follow these steps:

1. Make sure the printer is on but not printing, and letter-size paper is loaded.

Tip: For best results, load EPSON ink jet paper in the printer whenever you check 
the print head alignment.

2. Windows: Open an application and select Print from the File menu. Click 
Properties or Preferences. Then click the Utility tab.

Macintosh OS 8.5.1 to 9.x: Click the  Utility button.

Macintosh OS X: Open the Applications folder on your hard drive. 
Double-click EPSON Printer Utility and select SP 1280 in the printer list. Then 
click OK.

3. You see the Utility menu. Click the Print Head Alignment button.

4. Follow the instructions on the screen 
to print an alignment page for black 
printing. You see this window on 
your screen:
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5. On the test page, select the pattern with the 
two vertical lines most precisely printed on 
top of each other. You may need to use a 
magnifying glass or loupe.

Select one pattern each for rows 1, 2, and 3. 
Enter the number of the best pattern for 
each row in the corresponding boxes on the 
screen. Then click Next.

If you can’t find an aligned pattern, enter 
the number of the best pattern and click 
Realignment to print another test page. Then repeat this step.

6. Follow the instructions on the next two screens to print an alignment pattern for 
color printing.

7. On the test page, select the pattern that is the least grainy. Select one pattern for 
each of the two rows and enter its number in the corresponding boxes on the 
screen. Then click Finish.

If you can’t find a smooth pattern, enter the number of the best pattern and click 
Realignment to print another test page. Then repeat this step.
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Cleaning the Printer

To keep your printer working at its best, you should clean it several times a year. 
Follow these steps: 

1. Turn off the printer and wait for the Ppower light to go out.

2. Unplug the power cord and disconnect the printer cable.

3. Remove all the paper, then use a soft brush to clean any dust or dirt from the sheet 
feeder.

4. Clean ink out of the printer’s interior with a soft, damp cloth. 

Caution: Don’t touch the gears inside the printer.

Never use a hard or abrasive brush, or alcohol or thinner for cleaning; they can 
damage the printer components and case.

Don’t get water on the printer components, and don’t spray lubricants or oils inside 
the printer.

Don’t use any cleaning sheets included with special media; they may jam inside the 
printer.
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Transporting the Printer

If you move your printer some distance, you need to prepare it for transportation in 
its original box or one of a similar size. Follow these steps:

Caution: To avoid damage, always leave the ink cartridges installed when 
transporting the printer.

Be sure to remove the tape used in step 4 after installing the printer in its new 
location.

1. Turn on the printer, wait until the print head locks in the far right position, then 
turn the printer off.

2. Unplug the power cord from the electrical outlet. Then disconnect the printer 
cable from the printer.

3. Remove any paper from the printer and remove the paper support.

4. Open the printer cover. Secure the ink 
cartridge holder to the printer with tape as 
shown, then close the printer cover.

5. Push in the output tray extensions and 
close the tray.

6. Repack the printer and attachments in the 
original box using the protective materials 
that came with it. See the Start Here sheet 
for details.

Keep the printer level as you transport it. 

After transporting the printer, remove the tape 
securing the print head and test your printer. If you notice a decline in print quality, 
clean the print head (see page 5); if output is misaligned, align the print head (see 
page 11). 

Tape the ink cartridge holder to the 
printer case
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Problem Solving

This section gives you the basics for diagnosing and solving printer problems. 

■ First see “Diagnosing Printer Problems” on page 17 to help determine what the 
cause of the problem may be. 

■ Then see “Problems and Solutions” on page 20 for solutions to common setup 
and printing problems.

Caution: It’s a good idea to check EPSON’s support web site periodically for 
possible updates to your printer driver. Visit http://support.epson.com and check 
the section for your printer to see if there is a new driver available, free of charge, 
for downloading to your computer. Download instructions are posted for your 
convenience.
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Identifying Printer Parts

Sheet 
feeder

Left 
edge 
guide

Output tray extensions

Output tray

Printer cover

Paper support

Right edge guide

Control panel

Ink cartridge holders 
(not removable)

Paper 
thickness 
lever

Ink cartridge replacement button Roll paper 
button

Maintenance 
button

Power button

Maintenance light

Power light
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Diagnosing Printer Problems

You can diagnose some problems by checking the printer’s control panel lights, as 
described in this section, or running a printer check, as described on page 19.

Checking the Control Panel Lights

Follow the guidelines below when you check the control panel lights:

P is on or flashes The P power light is on when the printer is ready to print. It flashes 
when the printer is receiving a print job, charging ink, or cleaning the 
print head. It also flashes when the print head moves to the ink 
cartridge replacement position.

P and b flash When both the lights flash, one of the ink cartridges is low on ink. To 
find out which cartridge is low on ink, do one of the following:

■ Windows: Check the ink level graphic in the printer software. See 
page 16 for instructions on opening the software.

■ Macintosh OS 8.5.1 to 9.x: Click the  ink level icon in the 
printer settings dialog box. See page 20 for instructions on 
accessing the dialog box. 

■ Macintosh OS X: Choose Applications > EPSON Printer Utility 
> SP 1280 > EPSON StatusMonitor.

Then replace the ink cartridge as described on page 7.

Power buttonMaintenance buttonRoll paper button

Power 
light

Maintenance light
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P and b are on When both lights are on, one of the ink cartridges is out of ink. 
Determine which cartridge is empty. Then replace the cartridge as 
described on page 7. If both lights come on after you’ve replaced a 
cartridge, you may have installed a cartridge your printer can’t use. 

P is off and b 

is on
Jammed paper may be blocking movement of the print head, or you 
may have an internal error. Turn off the printer, open the cover, and 
check for any jammed paper. Also, make sure you removed all the 
packing material, as described on the Start Here sheet. Then turn the 
printer back on. If the error isn’t cleared, contact your dealer or EPSON. 
See page 29 for contact information.

P flashes and b 

is on
Paper is out or loaded incorrectly, or you have a paper jam.

If paper is out or loaded incorrectly, load or reload your paper. Then 
press the b maintenance button to turn off the b maintenance light 
and resume printing. (If you’re printing on roll paper, press the 
b maintenance button to turn off the b maintenance light, then press 
the z roll paper button to resume printing.) 

If paper is jammed, do one of the following:

■ If you’re printing on sheet paper, press the b maintenance button 
to try to clear the jam. If that doesn’t work, turn off the printer and 
gently pull the paper forward (toward the output tray) to pull it out. 
Then turn the printer on and press the b maintenance button to 
resume printing.

■ If you’re printing on roll paper, press the z roll paper button for at 
least three seconds to clear the jam. If that doesn’t work, see 
page 13 for details about clearing roll paper jams.

P and b are off When both lights are off, the printer is not receiving power. Try these 
solutions:

■ Make sure the printer is turned on.

■ Turn off the printer, plug in the power cord securely, and turn the 
printer on again.

■ Make sure the outlet is working and is not controlled by a switch or 
timer. If in doubt, try another outlet.
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Running a Printer Check

You can run a printer check to determine whether a problem comes from the printer 
itself or some other source. Follow these steps:

1. Make sure both the printer and computer are turned off. Then disconnect the 
interface cable from the printer.

2. Make sure letter-size or larger paper is loaded in the printer.

3. Hold down the b maintenance button, then press and release the Ppower 
button. Continue holding down the b maintenance button until the Ppower 
light starts to flash, then release it.

The printer prints one page showing its ROM version number, ink counter, and a 
nozzle check pattern. Only the nozzle check pattern is shown below. (If the 
pattern has gaps in its dots, you need to clean the print head; see page 5.)

4. To end the check, turn the printer off after it prints the check page. Then 
reconnect the interface cable and turn on your printer and computer.

If the check page prints, the problem probably lies in your software settings, the 
interface cable, or your computer. Another possibility is that your printer or 
application software may not be installed correctly.

If the check page doesn’t print, you may have a problem with your printer. Try the 
suggestions in “Problems and Solutions” beginning on page 20. If nothing seems to 
work, contact your dealer or EPSON as described on page 29.
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Problems and Solutions

Here are some troubleshooting tips if you have any problems setting up your printer, 
installing software, or printing.

Problems Setting Up 
the Printer or Installing 
Software

The printer makes noise after ink 
cartridge installation.

■ The first time you install ink 
cartridges, the printer must charge 
its ink delivery system for about 
two minutes. Wait until charging 
finishes (the Ppower light stops 
flashing) before you turn off 
the printer or it may charge 
improperly and use excess ink the 
next time you turn it on. If the 
printer stops moving or making 
noise, but the P power light is still 
flashing after 5 minutes, turn off 
the printer. If the light is still 
flashing when you turn it back on, 
contact EPSON as described on 
page 29.

■ Make sure the ink cartridge clamps 
are locked down completely and 
no packing material remains in the 
printer. Turn off the printer, wait 
a moment, then turn it back on to 
clear the error.

You’re having problems installing 
the printer software.

■ Make sure your printer is turned 
on and the printer cable is securely 
connected at both ends. Then 
carefully follow the installation 
instructions on the Start Here 
sheet. Also make sure your system 
meets the requirements beginning 
on page 31.

■ Close your other applications, 
including any screen savers and 
virus protection software, and 
install again.

■ For Windows NT or 2000, if you 
see an error message or your 
software doesn’t install correctly, 
you may not have software 
installation privileges. Contact 
your System Administrator.

■ If your printer icon (SP 1280) 
doesn’t appear in the Macintosh 
Chooser, you may have an 
extension conflict. Turn off any 
unnecessary extensions and restart 
your computer.
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■ For Windows 2000, don’t select 
Block under Control Panel> 
System> Hardware> Driver 
Signing; select Ignore or Warn 
instead.

■ Make sure Windows XP, Me, 
2000, or 98 was preinstalled on 
your system. The USB Printer 
Device Driver may not install 
correctly if you’ve upgraded your 
system from an earlier version of 
Windows.

■ Make sure the Universal Serial Bus 
Controller is working properly. See 
your Windows online help system 
for details. If it’s not working, 
contact your computer 
manufacturer.

■ If you’re printing over a network, 
see your on-screen Reference Guide 
for instructions on configuring your 
printer for use on a network.

Printing Problems

The Ppower light is on, but nothing 
prints.

■ Make sure the interface cable 
is connected securely and
the cable meets the system 
requirements on page 31 or 32.

■ Run a printer check as described 
on page 19. If the check page 
prints, make sure your printer and 
application software are installed 
correctly. 

■ If you’re printing on a network, you 
need to set up your printer for 
network printing, as described in 
your on-screen Reference Guide.

The printer sounds as though it is 
printing, but nothing prints.

■ Make sure the print head nozzles 
are not clogged. To clean the print 
head, see page 5.

■ The printer won’t operate properly 
if it’s tilted or at an angle. Place it 
on a flat, stable surface.

Your printer makes noise when you 
turn it on or after it has been sitting 
for awhile.

Your printer is performing routine 
maintenance.
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Printing is too slow.

Make sure your system meets the 
requirements listed in “Notices.” If 
you’re printing a high-resolution image, 
you need more than the minimum 
requirements listed. 

You may also need to:

■ Clear space on your hard disk or 
run a defragmentation utility.

■ Close open applications that you’re 
not using.

■ Increase your system’s memory 
(RAM).

For the fastest printing, try these tips:

■ Choose Black ink if your document 
doesn’t include color.

■ Set the Quality/Speed slider to 
Speed.

■ Turn MicroWeave® off and/or 
turn High Speed on. In Windows 
and Macintosh OS 8.5.1 to 9.x, 
these settings are on the Advanced 
window. In Macintosh OS X, these 
settings are on the Print Settings 
window.

■ If you’re using the parallel port, 
enable ECP/DMA mode. See your 
computer documentation or 
contact the manufacturer for help.

Print Quality Problems

You see banding (light lines).

■ The print head nozzles may need 
cleaning; see page 5 for 
instructions. 

■ Make sure the Media Type setting 
matches the paper you loaded; see 
page 32 for guidelines.

■ Make sure the printable side of the 
paper is face up. It’s usually whiter 
or shinier.

■ The ink cartridges may need 
replacing. To replace an ink 
cartridge, see page 7.

■ Try using Automatic mode. See 
page 16 (Windows), page 20 
(Macintosh OS 8.5.1 to 9.x) or 
page 23 (Macintosh OS X) for 
instructions.

■ Run the Print Head Alignment 
utility; see page 11 for instructions.
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■ Set the paper thickness lever to the 
0 position. Set the lever to the + 
position when you print on thicker 
paper or envelopes. You may also 
need to turn off High Speed in the 
printer software.

Your printout is blurry or smeared.

■ Make sure your paper isn’t damp or 
curled, or loaded face down (the 
printable side should be face up). If 
it’s damp or curled, reload a new 
stack of paper.

■ Use a support sheet with special 
paper, or try loading your paper 
one sheet at a time.

■ Make sure your paper meets the 
specifications listed in the on-screen 
Reference Guide. 

■ Use EPSON papers to ensure 
proper saturation and absorption 
of genuine EPSON inks. 

■ Run the Print Head Alignment 
utility. See page 11 for instructions.

■ Check the paper thickness lever 
position. If it’s in the + position, 
your printer is set for thicker paper 
or envelopes. If you’ve loaded other 
paper, your image may smear. For 
most papers, set the paper thickness 
lever to the 0 position, as shown to 
the left.

■ Remove each sheet from the output 
tray after printing, especially when 
you’re printing on transparencies.

Your printout is faint or has gaps in 
the image.

■ The print head nozzles may need 
cleaning; see page 5 for 
instructions. 

■ The ink cartridges may be old or 
low on ink. To replace an ink 
cartridge, see page 7. 
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■ Make sure the Media Type setting 
matches the paper you loaded. See 
page 32 for guidelines.

■ Make sure your paper isn’t 
damaged, old, dirty, or loaded face 
down. If it is, reload a new stack of 
paper with the printable side up; it 
is usually whiter or shinier than the 
other side.

You see wrong or missing colors.

■ If you’re printing color images, 
make sure both your application 
and printer software are set for 
color printing.

■ The print head nozzles may need 
cleaning; see page 5 for 
instructions.

■ The ink cartridges may be old or 
low on ink. To replace an ink 
cartridge, see page 7.

■ Try turning off PhotoEnhance.™ 
Also check if you’re using a special 
effect that alters image colors, like 
Sepia. 

■ Try using Automatic mode. See 
page 16 (Windows), page 20 
(Macintosh OS 8.5.1 to 9.x), or 
page 23 (Macintosh OS X) for 
instructions.

■ The color profiles built into your 
printer software automatically 
reference your monitor profile. 
Make sure that your monitor is 
calibrated correctly.

■ Try changing the Gamma setting 
on the Advanced dialog box 
(Windows or Macintosh OS 8.5.1 
to 9.x) or the Color Management 
dialog box (OS X).

■ Your printed colors can never 
exactly match your on-screen 
colors. However, you can use a 
color management system—such as 
ICM (Windows) or ColorSync 
(Macintosh)—to get as close as 
possible. See page 25 or page 29 for 
details.

Your printout is grainy.

■ Try using a higher quality paper.

■ Select a higher Print Quality 
(resolution) setting. See page 25 or 
page 29 for instructions.

■ You may need to increase the image 
resolution or print it in a smaller 
size; see your software 
documentation.

■ Run the Print Head Alignment 
utility. See page 11 for instructions.



25

Problems with Paper 
Feeding

Too many copies are printing.

Check the Copies setting in both your 
printer software and application.

Paper doesn’t eject fully or is 
wrinkled.

■ If the paper doesn’t eject fully, you 
may have set the wrong paper size. 
Press the b maintenance button to 
eject the paper, then select the 
correct paper size.

■ If it’s wrinkled when it ejects, the 
paper may be damp or too thin. 
Reload new paper.

Paper doesn’t feed correctly or jams 
in the printer.

■ If paper doesn’t feed, remove it 
from the sheet feeder, reload it 
against the right edge, then slide the 
left edge guide against the paper.

■ If multiple pages feed at once, 
remove the stack from the sheet 
feeder, fan the edges to separate the 
sheets, and carefully reload it.

■ If paper jams, press the 
b maintenance button for 
several seconds to clear the jam. 
If that doesn’t work, turn off the 
printer and gently pull the paper 
forward (toward the output tray) to 
pull it out. Reload the paper and 
press the b maintenance button.

■ If you try to print while the 
b maintenance light is on, your 
paper won’t feed properly. Press 
the b maintenance button to turn 
off the light before you print.

If your paper loads incorrectly or jams 
frequently:

■ Use new, smooth, high-quality 
paper, loaded printable side up.

■ Don’t load paper above the arrow 
mark on the left edge guide.

■ Place the paper against the right 
edge and slide the left edge guide 
against it, but not too tightly. 

Roll paper doesn’t feed correctly.

■ To load paper correctly, gently hold 
the paper in place with your hand 
while you press the z button. 
Don’t force the paper to feed into 
the printer. Allow it to feed 
automatically.

■ Use a triangle or other tool to 
make sure the end of the roll is cut 
perpendicular to the edges. If the 
end is cut on a diagonal, the paper 
may not feed smoothly. 
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■ If you see a paper jam error 
message, press the z roll paper 
button for at least three seconds to 
clear the error.

■ If the b maintenance light is on, 
press the b maintenance button 
and wait for the light to go off. 
Then press the z roll paper button 
to resume printing.

■ Always select Roll Paper as the 
Paper Source setting. If Sheet 
Feeder (or Auto Sheet Feeder) 
is selected, paper will feed 
unnecessarily after each print job. 
In addition, a great deal of paper 
may feed unnecessarily when you 
turn your computer off and then on 
again.

■ If extra paper feeds after a print job 
or after you turn on the printer, 
press the z roll paper button for 
three seconds to rewind the paper. 
(You may need to repeat this step to 
rewind the paper completely.) Then 
press the b maintenance button to 
turn off the b maintenance light. 
Finally, reload the paper and press 
the z roll paper button again to 
resume printing.

■ If paper is curled, roll the paper 
inside the uncurling sheet in the 
direction opposite to the paper’s 
curl. You don’t need to uncurl the 
entire roll—only about 9.3 inches. 
See page 11 for details.

Solving Miscellaneous 
Printout Problems

The image is inverted, as if viewed in 
a mirror.

Turn off Flip Horizontal in the 
Advanced dialog box or the mirror 
setting in your application. (If you’re 
printing on EPSON Iron-On Transfer 
Paper, the image should be inverted.)

The printer prints blank pages.

■ Make sure your printer is selected 
in Windows, or as the active printer 
in the Macintosh Chooser or Print 
Center.

■ The print head nozzles may need 
cleaning. See page 5. 

The margins are incorrect.

■ Make sure the paper settings in 
your printer software are correct for 
your paper size. See page 16 
(Windows), page 19 (Macintosh 
OS 8.5.1 to 9.x), or page 21 
(Macintosh OS X) for instructions.

■ See your software documentation 
for instructions on choosing the 
correct margins for your paper size. 
The margins must be within the 
printable area of the page. See 
“Printer Specifications” in your 
on-screen Reference Guide.
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Image size or position is incorrect.

Make sure paper and layout options are set correctly.

You see incorrect characters.

■ Make sure the interface cable is securely connected and meets the system 
requirements on page 31 or page 32. Then try printing again.

■ Make sure your printer is selected in Windows, or as the active printer in the 
Macintosh Chooser or Print Center. 

■ If you’re using a switch box or USB hub with your printer, connect the printer 
directly to your computer.

Uninstalling and Reinstalling Printer 
Software

You may need to uninstall and then reinstall your printer software. For example, this 
might be necessary when you upgrade your Windows operating system. You don’t 
need to uninstall your photo software or on-screen Reference Guide, and you won’t see 
the license agreement when you reinstall your software.

Note: You don’t need to uninstall your printer driver for OS X; you can reinstall 
the printer driver over the old driver.

Windows 

1. Windows XP: Click Start, then click the Control Panel icon. On the next 
screen, click Add or Remove Programs.

Other Windows systems: Double-click My Computer, then double-click 
the Control Panel icon. Finally, double-click Add/Remove Programs.

2. Click EPSON Printer Software in the program list, and click the Add/Remove 
button (Change/Remove button on Windows XP and 2000).

3. In the next window, make sure your EPSON Stylus Photo printer icon is selected 
and click OK. Then follow the on-screen instructions. 
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4. For all systems except Windows XP, click EPSON USB Printer Devices in the 
program list if you’re using a USB port; then click the Add/Remove (or 
Change/Remove) button. 

5. Restart your computer when you’re done. Then follow the instructions on the 
Start Here sheet to reinstall your software.

Macintosh OS 8.5.1 to 9.x

1. Insert your printer software CD-ROM and double-click the  EPSON icon 
in your CD-ROM window. (If you don’t see the window, double-click the

 EPSON icon that appears on your desktop.)

2. Click Install Printer Driver.

3. On the installer screen, click the arrow in the Easy Install list at the top and select 
Uninstall. Then click the Uninstall button at the bottom and follow the 
instructions.

4. Restart your Macintosh, then follow the instructions on the Start Here sheet to 
reinstall your software. 
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Where To Get Help

If you need help with your printer or Film Factory, see the contact information 
below. See the information on page 30 if you need help with the other photo software 
that came on your printer CD-ROM.

EPSON provides technical assistance 24 hours a day through the electronic support 
services and automated telephone services listed in the following table:

To speak to a technical support representative, dial:

■ U.S.: (562) 276-7296, 6 AM to 8 PM, Pacific Time, Monday through Friday and 
7 AM to 4 PM, Saturday. 

■ Canada: (905) 709-2567, 6 AM to 6 PM, Pacific Time, Monday through Friday.

Toll or long distance charges may apply. Before you call, please have the following 
information ready:

■ Product name (EPSON Stylus Photo 1280)

■ Product serial number (located on the back of the printer)

■ Proof of purchase (such as a store receipt) and date of purchase

■ Computer configuration and operating system version

■ Description of the problem

You can purchase ink cartridges, paper, manuals, and accessories from EPSON at 
(800) 873-7766, or visit www.epsonstore.com (U.S. sales only). In Canada, please call 
(800) 463-7766 for dealer referral.

Service Access

World Wide Web From the Internet, you can reach EPSON Support at 
http://support.epson.com. At this site, you can download 
drivers and other files, look at product documentation, access 
troubleshooting information, and receive technical advice 
through e-mail.

Automated 
Telephone Services

A variety of automated help services are available 24 hours a 
day, seven days a week. To use these services, you must have 
a touch tone telephone and call (800) 922-8911. Your 
SoundAdvice  Express Code is 68000. Use this code to quickly 
select the EPSON Stylus Photo 1280 in EPSON SoundAdvice.

SM
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Photo Software Technical Support

If you need help with the bonus photo software that came with your printer, please 
contact the software manufacturer, as listed below.

Software Web site E-mail Telephone

Adobe Photoshop 
Elements or LE

www.adobe.com/support/
main.html

techdocs@adobe.com (206) 675-6126
6:00 AM to 5:00 PM, 
PST, Monday 
through Friday (pay 
support)

MonacoEZcolor www.ezcolor.com/faq.html support@monacosys.com (888) 749-9944 
9:00 AM to 5:00 
PM, EST, Monday 
through Friday
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Notices

This chapter includes system requirements, safety instructions, legal notices, and other 
important information.

Windows System Requirements

To use your printer and its software, your system should have: 

■ A Microsoft® Windows® compatible PC with a Pentium® or better processor, 200 MHz 
or faster, recommended

■ Windows XP, Windows Me, Windows 2000, Windows 98, Windows 95, or 
Windows NT 4.0

■ 64MB of RAM (128MB or more recommended)

■ 150MB of free hard disk space (200MB or more recommended)

■ VGA or better display adapter and monitor

■ CD-ROM or DVD drive for installing the printer software

■ Parallel connection: a high-speed, bidirectional IEEE-1284 compliant parallel cable, up 
to 10 feet long (3 meters); the cable must have a D-SUB, 25-pin, male connector for your 
computer, and a 36-pin, Centronics® compatible connector for the printer.

USB connection: a computer running Windows XP, Windows Me, Windows 2000, or 
Windows 98 with a Windows-compliant USB port and a shielded USB “AB” cable up to 
6.5 feet (2 meters) long.

Caution: Using an improperly shielded USB cable—especially a cable more than 
6.5 feet (2 meters) long—may cause the printer to malfunction.
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Macintosh System Requirements

To use your printer and its software, your system should have: 

■ An Apple® iMac™ series or Power Macintosh® G3 or G4 with built-in USB port

■ Mac® OS 8.5.1 to OS 9.x, and OS X 10.1 to OS X 10.2

■ 64MB of available RAM (more recommended)

■ 150MB of free hard disk space (200MB recommended)

■ VGA display or better

■ CD-ROM or DVD drive for installing the printer software

■ A shielded USB “AB” cable up to 6.5 feet (2 meters) long.

Caution: Using an improperly shielded USB cable—especially a cable more than 
6.5 feet (2 meters) long—may cause the printer to malfunction.

ENERGY STAR Compliance

As an ENERGY STAR Partner, EPSON has determined 
that this product meets the ENERGY STAR guidelines for 
energy efficiency. The EPA ENERGY STAR office 
equipment program is a voluntary partnership with the 
computer and office equipment industry to promote the 
introduction of energy-efficient personal computers, 
monitors, printers, fax machines, and copiers in an effort to 
reduce air pollution caused by power generation.
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Important Safety Instructions

Before using your printer, read the following safety instructions to make sure you use the 
printer safely and effectively:

■ Be sure to follow all warnings and instructions marked on the printer.

■ Use only the type of power source indicated on the printer’s label.

■ Connect all equipment to properly grounded power outlets. Avoid using outlets on the 
same circuit as photocopiers or air control systems that regularly switch on and off. 

■ Place the printer near a wall outlet where the plug can be easily unplugged.

Placez l’imprimante près d’une prise de contacte où la fiche peut être débranchée facilement.

■ Do not let the power cord become damaged or frayed. 

■ If you use an extension cord with the printer, make sure the total ampere rating of the 
devices plugged into the extension cord does not exceed the cord’s ampere rating. Also, 
make sure the total ampere rating of all devices plugged into the wall outlet does not 
exceed the wall outlet’s ampere rating.

■ Keep your printer and computer system away from potential sources of electromagnetic 
interference, such as loudspeakers or cordless telephone base units.

■ Avoid locations that are subject to rapid changes in heat or humidity, shocks or 
vibrations, or dust.

■ Leave enough room around the printer for sufficient ventilation.

■ Do not place the printer near a radiator or heating vent or in direct sunlight.

■ Place the printer on a flat, stable surface that extends beyond the printer base in all 
directions. The printer will not operate properly if it is tilted or at an angle.

■ Turn off and unplug the printer before cleaning. Clean with a damp cloth only. Do not 
spill liquid on the printer.

■ Always turn the printer off using the P power button. The P power light flashes briefly 
and then goes off. Don’t switch off the power strip or unplug the printer until the 
P power light is off.

■ Do not block or cover the openings in the printer’s case or insert objects through the 
slots. 

■ Except as specifically explained in this manual, do not attempt to service the printer 
yourself. 
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■ Unplug the printer and refer servicing to qualified service personnel under the following 
conditions:

If the power cord or plug is damaged; if liquid has entered the printer; if the printer has 
been dropped or the case damaged; if the printer does not operate normally or exhibits a 
distinct change in performance. Adjust only those controls that are covered by the 
operating instructions.

Ink Cartridge Safety Instructions

■ Keep ink cartridges out of the reach of children and do not drink the ink. 

■ Be careful when you handle used ink cartridges; there may be ink remaining around the 
ink supply port. If ink gets on your skin, wash it off with soap and water. If it gets in your 
eyes, flush them immediately with water.

■ Do not put your hand inside the printer or touch the cartridge during printing.

■ Do not move the print head by hand. You may damage the printer.

■ Install the ink cartridge immediately after you remove it from its foil package. Leaving the 
cartridge unpacked for a long time before use can result in reduced print quality.

■ Do not use an ink cartridge beyond the date printed on the cartridge carton. For best 
results, use up the ink cartridges within six months of first installing them.

■ Store ink cartridges in a cool, dark place.

■ After bringing an ink cartridge inside from a cold storage site, allow it to warm up at 
room temperature for at least three hours before using it.

■ Do not shake an ink cartridge; this can cause leakage.

■ Do not dismantle the ink cartridges or try to refill them. This could damage the print 
head.

■ Do not touch the green IC chip on the side of the cartridge. This may affect normal 
operation and printing.

■ If you remove an ink cartridge for later use, protect the ink supply area from dirt and dust 
and store it in the same environment as the printer. Note that there is a valve in the ink 
supply port, making covers or plugs unnecessary, but care is needed to prevent the ink 
from staining items that the cartridge touches. Do not touch the ink cartridge ink supply 
port or surrounding area.

■ Before transporting the printer, make sure the print head is capped in the far right 
position and the ink cartridges are in place. Tape the ink cartridge holder to the printer 
case to make sure it remains in the proper position.
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FCC Compliance Statement

For United States Users

This equipment has been tested and found to comply with the limits for a Class B digital 
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable 
protection against harmful interference in a residential installation. This equipment generates, 
uses, and can radiate radio frequency energy and, if not installed and used in accordance with 
the instructions, may cause harmful interference to radio or television reception. However, 
there is no guarantee that interference will not occur in a particular installation. If this 
equipment does cause interference to radio and television reception, which can be determined 
by turning the equipment off and on, the user is encouraged to try to correct the interference 
by one or more of the following measures:

■ Reorient or relocate the receiving antenna.
■ Increase the separation between the equipment and receiver.
■ Connect the equipment into an outlet on a circuit different from that to which the 

receiver is connected.
■ Consult the dealer or an experienced radio/TV technician for help.

WARNING

The connection of a non-shielded equipment interface cable to this equipment will invalidate 
the FCC Certification of this device and may cause interference levels which exceed the limits 
established by the FCC for this equipment. It is the responsibility of the user to obtain and 
use a shielded equipment interface cable with this device. If this equipment has more than one 
interface connector, do not leave cables connected to unused interfaces. Changes or 
modifications not expressly approved by the manufacturer could void the user’s authority to 
operate the equipment.

For Canadian Users

This Class B digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.
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Declaration of Conformity

According to 47CFR, Part 2 and 15 for Class B Personal Computers and Peripherals; and/or 
CPU Boards and Power Supplies used with Class B Personal Computers:

We: EPSON AMERICA, INC. 

Located at: MS: 3-13
3840 Kilroy Airport Way
Long Beach, CA 90806-2469
Telephone: (562) 290-5254 

Declare under sole responsibility that the product identified herein, complies with 47CFR 
Part 2 and 15 of the FCC rules as a Class B digital device. Each product marketed is identical 
to the representative unit tested and found to be compliant with the standards. Records 
maintained continue to reflect the equipment being produced can be expected to be within 
the variation accepted, due to quantity production and testing on a statistical basis as required 
by 47CFR §2.909. Operation is subject to the following two conditions: (1) this device may 
not cause harmful interference, and (2) this device must accept any interference received, 
including interference that may cause undesired operation.

Trade Name EPSON

Type of Product: Ink Jet Printer

Model: EPSON Stylus Photo 1280: P158A
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Epson America, Inc. Limited Warranty

What Is Covered: Epson America, Inc. (“Epson”) warrants to the first retail purchaser that the 
EPSON printer covered by this limited warranty statement, if purchased and used in the 
United States or Canada, conforms to the manufacturer’s specifications and will be free from 
defects in workmanship and materials for a period of one (1) year from the date of original 
purchase. Epson also warrants that the consumable ink cartridges enclosed with the printer 
will perform to the manufacturer’s specified usage, which usage may expire before the 
expiration of the limited warranty for the EPSON printer. For warranty service, you must 
provide proof of the date of original purchase.

What Epson Will Do To Correct Problems: Should your EPSON printer prove defective during 
the warranty period, please call the EPSON Connection  at (562) 276-7296 (U.S.) or (905) 
709-2567 (Canada) for warranty repair instructions and return authorization. An Epson 
service technician will provide telephone diagnostic service to determine whether the printer 
requires service. If service is needed, Epson will, at its option, exchange or repair the printer 
without charge for parts or labor. If Epson authorizes an exchange for the defective unit, 
Epson will ship a replacement printer to you, freight prepaid, so long as you use an address in 
Canada or the U.S. (excluding Puerto Rico and U.S. Possessions). Shipments to other 
locations will be made freight collect. You are responsible for securely packaging the defective 
unit and returning it to Epson within five (5) working days of receipt of the replacement. 
Epson requires a debit or a credit card number to secure the cost of the replacement printer in 
the event that you fail to return the defective one. If your printer is being repaired, Epson will 
direct you to send your printer to Epson or its authorized service center, where the printer will 
be fixed and sent back to you. You are responsible for packing the printer and for all costs to 
and from the Epson authorized service center. When warranty service involves the exchange 
of the printer or a part, the item replaced becomes Epson property. The replacement printer 
or part may be new or refurbished to the Epson standard of quality, and, at Epson’s option, 
may be another model of like kind and quality. Epson’s liability for replacement of the 
covered printer will not exceed the original retail selling price of the covered printer. Exchange 
products and parts assume the remaining warranty period of your original product covered by 
this limited warranty.

SM
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What This Warranty Does Not Cover: This warranty covers only normal use in the United 
States and Canada. This warranty is not transferable and will not apply to products purchased 
from an end user. This warranty does not cover any color change or fading of prints or 
reimbursement of materials or services required for reprinting. This warranty does not cover 
damage to the EPSON product caused by parts or supplies not manufactured, distributed or 
certified by Epson. This warranty does not cover ribbons, ink cartridges or third party parts, 
components, or peripheral devices added to the EPSON product after its shipment from 
Epson, e.g., dealer or user-added boards or components. Epson is not responsible for warranty 
service should the Epson label or logo or the rating label or serial number be removed or 
should the product fail to be properly maintained or fail to function properly as a result of 
misuse, abuse, improper installation, neglect, improper shipping, damage caused by disasters 
such as fire, flood, and lightning, improper electrical current, software problems, interaction 
with non-Epson products, or service other than by an Epson Authorized Servicer. If a claimed 
defect cannot be identified or reproduced, you will be held responsible for the costs incurred.

THE WARRANTY AND REMEDY PROVIDED ABOVE ARE EXCLUSIVE AND IN 
LIEU OF ALL OTHER EXPRESS OR IMPLIED WARRANTIES INCLUDING, BUT 
NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, 
NON-INFRINGEMENT OR FITNESS FOR A PARTICULAR PURPOSE. SOME 
LAWS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES. IF THESE 
LAWS APPLY, THEN ALL EXPRESS AND IMPLIED WARRANTIES ARE LIMITED 
TO THE WARRANTY PERIOD IDENTIFIED ABOVE. UNLESS STATED HEREIN, 
ANY STATEMENT OR REPRESENTATIONS MADE BY ANY OTHER PERSON OR 
FIRM ARE VOID. EXCEPT AS PROVIDED IN THIS WRITTEN WARRANTY, 
NEITHER EPSON AMERICA, INC. NOR ITS AFFILIATES SHALL BE LIABLE FOR 
ANY LOSS, INCONVENIENCE, OR DAMAGE, INCLUDING DIRECT, SPECIAL, 
INCIDENTAL OR CONSEQUENTIAL DAMAGES, RESULTING FROM THE USE 
OR INABILITY TO USE THE EPSON PRODUCT, WHETHER RESULTING FROM 
BREACH OF WARRANTY OR ANY OTHER LEGAL THEORY.

In Canada, warranties include both warranties and conditions.

Some jurisdictions do not allow limitations on how long an implied warranty lasts, and some 
jurisdictions do not allow the exclusion or limitation of incidental or consequential damages, 
so the above limitations and exclusions may not apply to you. This warranty gives you specific 
legal rights and you may have other rights which vary from jurisdiction to jurisdiction.

Epson America, Inc.  O   P.O. Box 93012  O   Long Beach, CA 90809-3012 
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Index

Numerics

360 dpi Ink Jet Paper setting, 32

A

Accessories, 46, 67
Adobe Photoshop, P.I.M. II plug-in for, 39 to 42
Aligning print head, 49 to 50
Automatic mode, 17, 20, 23

B

Banding, 60 to 61
Basic printing

Macintosh OS 8.5.1 to 9.x, 19 to 21
Macintosh OS X, 21 to 24
Windows, 16 to 18

Blank pages, 64
Blurry images, 61
Booklet, printing, 28
BorderFree printing, 33 to 34, 37
Bright White Paper, 32
Browser, 4
Buttons, printer, 54

C

Cable, printer, 69 to 70
Cancelling printing, 18, 21, 24
Centering text or image, 27
Characters, incorrect, 65
Checking printer, 57
Cleaning

print head, 43 to 45
printer, 51
sheets, 51

Collating print jobs, 17

Color Management settings
Mac OS 8.5x to 9.x, 29 to 30
Mac OS X, 24
Windows, 26

Color problems, 62
ColorLife Photo Paper, 32
ColorSync, 24, 29
Control panel, 54, 55 to 56
Controlling printing, 18, 21, 24
Copies setting, 63
Customizing print settings

Macintosh, 29 to 31
Windows, 25 to 28

D

Default settings, Windows, 18
Documentation, 4 to 6
Double-Sided Matte Paper, 32
Double-sided printing, 23, 28

E

Economy setting, 25, 29
Electronic manual, 4 to 6
Elements, Photoshop

description, 3
using P.I.M. II Plug-in, 39 to 42

EPSON
accessories, 46, 67
help, 67
Monitor3, 21
papers, 32
PhotoCenter, 3
Store, 46, 67
support site, 53

Error lights, 54, 55 to 56
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Exif Print
description, 2
with Film Factory, 35 to 38
with plug-in for Photoshop, 39 to 42

F

Faint images, 61
Film Factory, 35 to 39
Flip Horizontal setting, 64

G

Gamma setting, 26, 30
Glossy media, 32

H

Head Cleaning utility, 43 to 45
Help, EPSON, 67
High Speed setting, 60
Holding a print job, 18, 21, 24

I

ICC profiles, using with P.I.M. II Plug-in, 
39 to 42

ICM setting, 25
Image, resizing, 28
Incorrect characters, 65
Incorrect colors, 62
Ink cartridge

replacing, 45 to 48
safety instructions, 72

Ink jet transparencies, 32
Ink level, 18, 20, 45, 47, 55
Ink setting, 17, 20, 23
Installation problems, 58 to 59
Inverted image, 64
Iron-On Transfer Paper, 32, 64

J

Jams, paper, 13, 56, 63 to 64

L

Landscape orientation, 22, 27
Layout problems, 65
Layout settings, 19, 24, 28
Lever, thickness, 61
Lights, 54, 55 to 56
Loading paper, 7 to 13

M

Macintosh
basic printing, 19 to 24
cancelling printing, 21, 24
customizing print settings, 29 to 31
Media Type setting, 20, 23
printer status, 21, 24
prioritizing print jobs, 21, 24
saving your settings, 24, 31
setting resolution, 30
system requirements, 70
USB, 70

Maintaining printer, 43 to 51
Marginless printing, 33 to 34, 37
Margins, incorrect, 64
Matte papers, 32
Media Type setting, 17, 20, 23, 32
MicroWeave setting, 60
Mirror images, 64
MonacoEZcolor, 3, 68
Monitor3, EPSON, 21
Monitoring ink level, 18, 20, 21, 45, 47, 55
Moving printer, 52

N

Network printing, 59
Noise, printer, 59
Nozzle check pattern, 44 to 45, 57
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O

Orientation setting, 22, 27, 33

P

P.I.M. II Plug-in, 3, 39 to 42
Page Setup, Macintosh, 19, 21
Panoramic paper, 32
Paper

EPSON, 32
feeding problems, 13, 63 to 64
jams, clearing, 56
loading, 7 to 13
orientation, 22, 33
Source setting, 19, 27, 37
thickness lever, 61
type, setting, see Media Type setting

Paper Size setting, 19, 22, 27
Pausing printing, 18, 21, 24
Photo Paper, 32
Photo software, 3, 68
Photo Stickers, 32
PhotoCenter, 3
Photoshop, 3, 68

using P.I.M. II Plug-in, 39 to 42
Portrait orientation, 22, 27
Poster, printing, 28
Power light, 55
Premium Bright White Paper, 32
Previewing print job, 20
Print dialog box, 16
Print head

aligning, 49 to 50
cleaning, 43 to 45

PRINT Image Matching
description, 1 to 2
plug-in for Photoshop, 39 to 42
with Film Factory, 35 to 39

Print quality problems, 60 to 62
Printable area, increasing, 27

Printer
cable, 69 to 70
check, 57
cleaning, 51
control panel, 54, 55 to 56
maintaining, 43 to 51
noise, 59
parts, 54
problems, 55 to 57, 59 to 60
status, 18, 21
transporting, 52

Printing
basic, 16 to 24
booklet, 28
BorderFree, 33 to 34, 37
controlling, 18, 21, 24
customizing, 25 to 31
double-sided, 23, 28
increasing printable area, 27
on roll paper, 27
poster, 28
previewing, 20
prioritizing print jobs, 21, 24
rough drafts, 25, 29
setting higher resolution, 26, 30
slow, 60
with PRINT Image Matching, see PRINT 

Image Matching
Problems

installing software, 58 to 59
miscellaneous, 64 to 65
paper feeding, 13, 63 to 64
print quality, 60 to 62
printing, 59 to 60

Profiles, ICC, using with P.I.M. II Plug-in, 
39 to 42

Progress Meter, 18

Q

Quality/Speed setting, 17, 20
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R

Reference Guide, 4 to 6
Reinstalling software, 65 to 66
Resizing image, 28
Resolution, setting higher, 26, 30
Roll paper

clearing jams, 56
feeding problems, 13, 63 to 64
loading, 10 to 13
printing, 27
removing, 14
storing, 14

Rotating image, 27

S

Safety instructions, 71 to 72
Saving settings, 24, 26, 31
Self adhesive sheets, 32
Service, 67 to 68
Slow printing, 60
Smears, 61
Software

photo, 3, 68
problems, solving, 58 to 59
uninstalling, 65 to 66
updates, 53

Source, Paper, 19, 27, 37
sRGB setting, 25
Stickers, 32
Support, 67 to 68
System requirements, 69 to 70

T

Technical support, 67 to 68
Thickness lever, 61
Transfer Paper, Iron-On, 32, 64
Transparencies, 32
Transporting printer, 52
Troubleshooting, 53 to 65

U

Uninstalling software, 65 to 66
Updates, software, 53
USB, 66, 69, 70
Utilities

Head Cleaning, 43 to 45
Print Head Alignment, 49 to 50

W

Watermark, adding, 20, 28
Windows

basic printing, 16 to 18
cancelling printing, 18
customizing print settings, 25 to 28
default settings, 18
layout settings, 28
Media Type setting, 17
printer status, 18
saving your settings, 26
setting higher resolution, 26
system requirements, 69
uninstalling software, 65
USB, 66, 69

World Wide Web, 67
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EPSON Ink Jet Papers

Use EPSON paper and inks to get the same photo quality results that earn EPSON printers all of their 
awards! EPSON papers are specially coated to work with EPSON genuine inks. You’ll notice that 
when prints come out of your printer, your image is crisp and smooth. Here are details about just a few 
of EPSON’s papers, your printer’s ink cartridges, and EPSON project ideas:

Borderless Premium Glossy Photo Paper

Water-resistant, photographic-weight paper featuring EPSON’s BorderFree™ 
technology, this paper lets you print frame-ready photos in a matter of minutes.

ColorLife Photo Paper

ColorLife™ Photo Paper delivers colorful, fade-resistant photos with a smooth 
satin finish. Results are brilliant, professional images that look and feel like 
traditional photographs.

Matte Paper Heavyweight

Professional-looking, flat matte finish for printing photos and graphics on a 
non-glossy surface. Perfect for digital fine art work. Your prints last longer than 
with other media, especially when you display them under glass or store them 
in photo albums.

EPSON Ink Cartridges

For best results, always use genuine EPSON ink cartridges.

T007201 (Black) T009201 (Color)

For more information on other EPSON products and fun project ideas, 
look for the EPSON Print Lab  Series at www.printlabseries.com.

See the inside back cover for a partial list of EPSON papers and ordering information.

SM



How To Order EPSON Ink and Paper

To order EPSON ink cartridges and paper, call (800) 873-7766 or visit the EPSON Store at www.epsonstore.com (U.S. sales 
only). In Canada, please call (800) 463-7766 for dealer referral.

EPSON Ink Cartridges
T007201 (Black)
T009201 (Color)

EPSON Papers
Paper name Size Part number

EPSON Premium Bright White Paper Letter (8.5 x 11 inches) S041586

EPSON Photo Quality Ink Jet Paper Letter (8.5 x 11 inches) S041062

EPSON Photo Quality Ink Jet Cards A6 (4.1 x 5.8 inches) S041054

EPSON Glossy Photo Paper (EPSON Photo 
Paper)

4 x 6 inches, non-perforated, BorderFree S041458

Letter (20, 100, or 500 sheets, respectively) S041141/ S041272/ S041271

Panoramic (8.3 x 23 inches) S041145

13 inches x 32.8 feet (Super B Roll) S041233

EPSON ColorLife Photo Paper Letter (8.5 x 11 inches)
13 x 14 inches

S041500
S041501

EPSON Double-Sided Matte Paper Letter (8.5 x 11 inches) S041568

EPSON Matte Paper Heavyweight Letter (8.5 x 11 inches) S041257

8 x 10 inches, BorderFree S041467

11 x 14 inches S041468

Super B (13 x 19 inches) S041263

EPSON Premium Glossy Photo Paper Letter (8.5 x 11 inches) S041286

5 x 7 inches, BorderFree S041464

8 x 10 inches, BorderFree S041465

11 x 14 inches S041466

Super B (13 x 19 inches) S041289

4 inches x 26.2 feet (Roll) S041302

8.3 inches x 26.2 feet (Roll) S041376

EPSON Premium Semigloss Photo Paper Letter (8.5 x 11 inches) S041331

Super B (13 x 19 inches) S041327

4 inches x 26.2 feet (Roll) S041329

EPSON Premium Luster Photo Paper Letter (8.5 x 11 inches) S041405

8.3 inches x 26.2 feet (Roll) S041408

EPSON Photo Stickers Kit (CD-ROM/paper) A6 (4.1 x 5.8 inches) S041144-KIT

EPSON Photo Quality Glossy Film Letter (8.5 x 11 inches) S041072

EPSON Ink Jet Transparencies Letter (8.5 x 11 inches) S041064

EPSON Glossy Photo Greeting Cards Letter (8.5 x 11 inches); perforated edges S041606

EPSON Photo Quality Self Adhesive Sheets A4 (8.3 x 11.7 inches) S041106

EPSON Iron-On Transfer Paper Letter (10 or 50 sheets) S041153/ S041155
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